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Copyrights and Trademark Notices
Copyright © 2017 Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream, Flip4Mac, FlipFactory, Episode, Telestream MAP, MetaFlip, GraphicsFactory, 
MotionResolve, ScreenFlow, and Split-and-Stitch are registered trademarks and 
Pipeline, Launch, Wirecast, Videocue, Drive-in, and Vantage are trademarks of 
Telestream, LLC.

QuickTime, Mac OS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour 
logo, and the Bonjour symbol are trademarks of Apple, Inc.

Microsoft, Windows Media Technologies and Silverlight are trademarks of Microsoft 
Corporation.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

AudioRestore, iZotope®; ©2011 iZotope, Inc. All Rights Reserved.

Sparkle, copyright (c) 2006 Andy Matuschak.

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the "Software"), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ScreenFlow User Guide
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ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.

RSS reader class, copyright (c) 2002, Brent Simmons. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of ranchero.com or Brent Simmons nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This project uses software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit (http://www.openssl.org). This toolkit is licensed as follows:

Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the 
following acknowledgment: "This product includes software developed by the 
OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or 
promote products derived from this software without prior written permission. For 
written permission, please contact: openssl-core@openssl.org.
ScreenFlow User Guide
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5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" 
appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: 
"This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

ShortcutRecorder, copyright 2006-2007 Contributors. All rights reserved.

License: BSD

Jesper, waffle software, <wootest+shortcutrecorder@gmail.com>

David Dauer, <david@daviddauer.de>

Jamie Kirkpatrick, Kirk Consulting Ltd, <jkp@kirkconsulting.co.uk> 

CTGradient, v 1.5, copyright (c) 2006 Cotingent.

Created by Chad Weider on 12/3/05.

Some rights reserved: http://creativecommons.org/licenses/by/2.5/
ScreenFlow User Guide
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Limited Warranty and Disclaimers
Telestream, LLC. (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), is free from defects in materials and workmanship under normal 
operating conditions and use.

Software—If software is supplied as part of the product, the software will operate in 
substantial conformance with specifications set forth in its product user's guide. The 
Company does not warrant that the software will operate uninterrupted or error-free, 
will meet your requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality.

Software—If software is supplied as part of the product and it fails to substantially 
confirm to its specifications as stated in the product user's guide, the Company shall, at 
its own expense, use its best efforts to correct (with due allowance made for the nature 
and complexity of the problem) such defect, error or nonconformity.

Software Updates—If software is supplied as part of the product, the Company will 
supply the registered purchaser/licensee with maintenance releases of the Company’s 
proprietary Software Version Release in manufacture at the time of license for a period 
of one year from the date of license or until such time as the Company issues a new 
Version Release of the Software, whichever first occurs. To clarify the difference 
between a Software Version Release and a maintenance release, a maintenance release 
generally corrects minor operational deficiencies (previously non-implemented 
features and software errors) contained in the Software, whereas a Software Version 
Release adds new features and functionality. The Company shall have no obligation to 
supply you with any new Software Version Release of Telestream software or third party 
software during the warranty period, other than maintenance releases.
ScreenFlow User Guide
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Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, INC. WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product.

Damages
TELESTREAM, LLC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC.
848 Gold Flat Road
Nevada City, CA 95959

You can call Telestream, Inc. via telephone at (530) 470-1300.

Part Number: 210377

Publication Date: February 2017
ScreenFlow User Guide
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Getting Started
These tours are designed to introduce you to the capabilities and significant features of 
ScreenFlow.

We encourage you to take these tours before beginning a screencast or other 
ScreenFlow project. They help you to gain a basic understanding of how ScreenFlow 
works and help to familiarize yourself with the program.

The creation of a ScreenFlow screencast is a three step process: first you record your 
video, next you edit your screencast project, and finally you export your screencast to a 
video file or publish it directly to an Internet video service such as YouTube and others.

For video tutorials, please visit our ScreenFlow demos page.

 Tour 1—Recording With ScreenFlow

 Tour 2– Editing Your Screencast

 Tour 3—Publishing Your Screencast

http://www.telestream.net/telestream-support/screen-flow/training.htm
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Tour 1—Recording With ScreenFlow
This first tour focuses on creating a high quality recording for editing and publishing. 
When creating a screencast, it is important to prepare your recording properly while 
considering how you intend to use this screencast.

We recommend that you record a few sample screencasts to familiarize yourself with 
ScreenFlow and its options, before creating a screencast for publication.

To record a screencast with ScreenFlow, follow these basic steps:

1. Open your Applications folder.

2. Drag ScreenFlow onto your dock bar.

3. Double-click the ScreenFlow icon to launch the application.

When you launch ScreenFlow, it displays a Welcome window.

Figure 1. Screenflow Welcome Window
ScreenFlow User Guide
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When you’re ready to start recording, select New Recording to display the Configure 
Recording window.

Figure 2. Configure Recording Window

Configuring Your Recording
Use the Configure Recording window to specify your recording sources. This opens 
when you launch the application and select New Recording.  It can also be accessed 
from ScreenFlow Helper > Configure Recording.

Record Desktop from. This option records your computer display. If you have multiple 
displays connected, you can choose between them but ScreenFlow cannot record 
multiple displays simultaneously.

Record Screen from. This option records a screen from a selected device. If you have 
multiple devices connected, you can choose between them but ScreenFlow cannot 
record multiple devices simultaneously.

Record Video from. This option records video from any camera connected to your 
computer. Use the popup menu to choose from multiple cameras. Upon selecting a 
source, a preview image displays below.

Record Audio from. This option records from any microphone connected to your 
computer. Use the popup menu to choose from multiple microphones. Upon selecting 
the source, the volume level is displayed below.

Select New 
Recording
ScreenFlow User Guide
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Record Computer Audio. Choose this option to record all sounds played through your 
computer. The ScreenFlow audio driver must be installed to use this setting. If the 
driver is not installed, you are prompted to install it.

Beginning Your Recording
When you are ready, click the Record button. ScreenFlow enters a countdown mode 
before recording. You can change the length of this countdown (see Using the 
Countdown Window). 

Create a short presentation then stop your recording: press Shift-Command-2 or select 
Stop Record from the ScreenFlow Helper menu in the upper-right corner of your 
display. 

When you stop recording, ScreenFlow opens your recording in the ScreenFlow editing 
window with all of your recorded sources placed on the timeline.

Display video and computer audio are combined into one clip; camera video and 
microphone audio are combined in another clip, to maintain video/audio sync. Video 
and audio can be separated by selecting the clip and choosing Edit > Detach Audio.

Partial Screen Capture
Partial screen capture enables you to record just a portion of the screen. 

The partial screen record button (the dashed rectangle icon) is located to the left of the 
main record button. When clicked, the screen will darken and a rectangular selection 
will appear. This capture area can be resized using the mouse. While the rectangular 
selection  is present, the user cannot interact with any windows on their desktop, and 
the mouse is now controlling the sizing of the region. 

Cancel
Record

Presets

Partial screen 
record button
ScreenFlow User Guide
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There is a control strip at the bottom of the focused screen where you can cancel out of 
this mode, start the recording, or use presets to constrain the region you are capturing. 
(See Partial Screen Capture for more detail).

Advanced Settings  
The Advanced Settings button above the Record button in the Configure Recording 
window switches to the Timed Recording pane. In addition to setting the Desktop 
Framerate, you can record in a loop or record for a set duration.  (See Advanced Settings 
for more detail).

Advanced 
settings 
button
ScreenFlow User Guide
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Tour 2– Editing Your Screencast
The purpose of this tour is to familiarize you with the basic editing features of 
ScreenFlow. This tour describes some of the most common and basic editing 
techniques.

For a comprehensive description of editing features, see Editing ScreenFlow Projects.

When you finish your recording, ScreenFlow creates a new document and recorded 
media is placed at the beginning of the timeline. The media elements on the timeline 
reference your project’s stored media. Changes made on the timeline or on the canvas 
do not alter your original recording.

The Editing Window
The space used for editing is the editing window, which consists of three main parts: 
Canvas Control, Playback Controls, and Timeline area.

Figure 3. Editing Window

Canvas Controls

The large, central area of the editing window is called the canvas. This offers a preview 
of all visual elements in your project. The gray space around the preview is for elements 
that will not be present in your exported video. This is used to display off-screen 

Canvas

Timeline areaCanvas controls Playback controls

Properties
ScreenFlow User Guide
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elements present in scaling and panning effects. The elements displayed on the canvas 
reflect the position of the scrubber on the timeline.

You can set the canvas size and background color using the canvas controls (see 
Configuring the Canvas).

Timeline Area

The wide area at the bottom of the screen is the timeline. This is a visual representation 
of the temporal length of your screencast. The scale at the top of the timeline 
represents measurements of time.

The red vertical line on the timeline is called the scrubber. This represents the current 
temporal position of the preview currently displayed on the canvas.

The timeline is divided into tracks to manage different clips overlapping at the same 
time. If the clip is visual (i.e. video, image, or text), the upper most track is displayed over 
the lower tracks.

Between the canvas and the timeline are playback controls which enable you to play 
your screencast and jump to the beginning or end of your video.

Properties

On the upper-right side of the editing window are the Properties tabs. These are the 
main editing controls of ScreenFlow and allow you to configure each clip in your 
screencast. It also includes the media library which stores all recorded and imported 
media in an unaltered state.

For more information, see the Properties topics in Editing ScreenFlow Projects.

ScreenFlow provides two different types of cropping.

Canvas Cropping
Canvas cropping is used to change the resolution or aspect ratio of the workspace you 
have to edit in. This can be useful if you want to constrain your screencast to only a 
portion of the total recording (i.e. a foreground window).

Canvas cropping is accessible through the canvas cropping button located on the left 
side of the tool bar. 

This is set by numerically entering the width and height values or dragging the edge of 
the canvas with your mouse cursor.

The canvas can be set to a size larger than the original recording by using the 
File>Document Settings . Remember, the canvas size represents your total usable 
display space, which converts to the frame size of your video when you export or 
publish it.

Canvas cropping button
ScreenFlow User Guide
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Figure 4. Canvas Controls

Image Cropping
To crop an image, select the video or still image on the canvas. Hold the Control key 
and drag the edge or handles of the image to constrain and crop it. Hold the Control 
and Shift keys and drag to just crop the image.

Actions
Actions are property changes used to transition the media from one state to another. 
Actions are added to a clip by selecting the clip, opening the property that you want to 
alter, then clicking the Add Action button (+Action) at the top of the properties pane. 
The action is placed in relation to the position of the scrubber, but can be moved on the 
clip. The duration of the action is changed by dragging the edge of the action to 
lengthen or shorten the action.

Figure 5. Video Properties Action

Place the scrubber before or after the action to make changes to the property relative 
to the action. When the scrubber is placed before the action, this sets the properties of 
ScreenFlow User Guide
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the clip before the action. When the scrubber is placed after the action, this sets the 
properties of the clip after the action.

Video Properties
Video properties can be used to make changes to any recorded or imported video, 
video action, or image file. This includes both screen and camera recordings.

This tour focuses on the most common features. For more details, see Configuring Video 
Properties.

Figure 6. Video Properties

Scale. Use this option to change the size of a video or image relative to the size of the 
canvas. This can be used for highlighting a particular portion of the screen or with a 
video action to create a zoom effect.

Use the slider or enter a percentage value to change the image scale.
ScreenFlow User Guide
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Position. Position represents the location of your video or image on the canvas. The 
position is based on the exact placement of the center of your image. Values in the 
position field are represented in pixels. You cannot reposition the clip on the canvas 
with arrow keys all of the time. The clip must be selected using the mouse. If the clip is 
selected on the timeline, the arrow keys do not adjust the location of the clip on the 
canvas.

You can reposition the image by dragging the image on the canvas, nudging the image 
with the arrow keys, or entering a numerical value in the position fields.

XYZ Rotation. You can rotate the image on its X, Y, or Z axis by entering a value in 
degrees, or by clicking and dragging (in circular motion) the rotation icon to the right of 
the value field.

Opacity. This is the degree to which the image is translucent. The greater the value, the 
more opaque the image. If the value is set to zero, the image is invisible.

This is used with a video action to fade an image in or out. It is particularly useful if you 
would like to periodically display your camera recording.

Cropping Click the disclosure triangle down to display cropping options. Set the crop 
margins (by pixel) for left, right, bottom, and top. 

Reflection Check to implement reflection. Use the slider to set the value or enter it 
manually (0 to 100%).  Reflection creates a mirror image of the selected clip below the 
clip itself. The greater the value, the more opaque the reflection. When set to zero, the 
reflection is invisible.

Shadow Check to create a shadow effect behind a still image. If the image uses a 
transparency, the shadow only reflects the non-transparent part of your image. Use the 
thumb wheel (or enter the value manually) to set the angle of the shadow relative to 
the image in degrees (-180 to 80 degrees). The default is -45 degrees.

Color Controls Click the disclosure triangle down to display color options, and adjust 
saturation, brightness, and contrast using the sliders.

Video Filters Click the plus icon to add filters to the selected clip.

Screen Recording Properties
Screen recording properties are effects specific to demonstrations using the mouse and 
keyboard. They can only be applied to screen recording clips.

This tour focuses on the most common features. For more details, see Configuring 
Screen Recording Properties.
ScreenFlow User Guide
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Figure 7. Screen Recording Properties

Pointer Zoom. Often it can be difficult to see the mouse in a screencast, particularly if 
the video has been significantly resized. Increasing the pointer zoom value makes the 
mouse cursor larger and easier for the viewer to follow.

Click Effect. This feature can be used to make a visual effect when you click your 
mouse. Select Radar to screencast a red circle with each click or Invert to change the 
cursor from black to white with each click.

Sound on Click. Select this option to generate a click sound when the mouse button is 
pressed.

Show All Keys. Select this option to display the text as you were typing it while 
recording.

Show Only Modifier Keys. Select this option to display modifiers used in hotkey 
commands, F1 through F12, and the arrow keys.
ScreenFlow User Guide
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Callout Properties
Callout Properties are used to highlight a specific portion of the screen. They can be 
applied to screen recordings, images, or video clips. Unlike the other properties, Callout 
Properties must be used with an action.

This tour focuses on the most common features. For more details, see Configuring 
Callout Properties.

Figure 8. Callout Properties

Highlight. Callouts are capable of highlighting an area in three different ways. Mouse 
cursor highlights a circular space around the mouse cursor. Foreground Window 
highlights any window which is currently active. Freehand allows you to draw the area 
you want to highlight.

Opacity. The opacity slider controls the opacity of the space outside the callout. A low 
value makes the surrounding area more visible, while a high value makes the 
surrounding area less visible.

Zoom Up. This option magnifies the area inside the callout to make it more prominent.

Border. This option increases the range of the callout area to draw attention to a larger 
space. This feature is not available with freehand callouts.
ScreenFlow User Guide
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Touch Callout Properties
Touch callouts work in a similar fashion to freehand callouts. When the action is 
selected in the timeline, the video view enters a modal editing state, which is 
represented by the timeline. Only the currently selected clip and some editing controls 
in the top right corner of the video view are highlighted. This modal editing state can 
be exited by clicking away from the touch callout, or by clicking the close button on the 
editing tools.

The touch callouts are configured through a tab in the ScreenFlow inspector where the 
touch callouts can also be added. 

Touch Callout tab
ScreenFlow User Guide
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Media Library
The media library stores all recorded and imported media in an unaltered state. This 
media may be dragged from the media library to your timeline or canvas for inclusion 
in the project. You can drag this media into your project multiple times to replicate the 
same file. 

For more information, see Using the Media Library.
ScreenFlow User Guide
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Tour 3—Publishing Your Screencast
The purpose of this tour is to familiarize you with publishing your screencast. 
ScreenFlow screencasts are not video files—they are saved as ScreenFlow documents 
(with a .screenflow extension), which can only be opened and used by ScreenFlow.

There are two ways to publish your screencasts—by exporting them to a standard 
video file format or publishing them directly to an Internet video service, like Vimeo or 
YouTube.

Determining the correct export settings for your screencast depends on the complexity 
of your screencast and the intended use of the video after it has been produced.

This tour explores the basics of ScreenFlow’s export options. For a comprehensive 
description, see Publishing Your ScreenFlow Project.

Select File > Export or press Command-E to export your presentation:

Figure 9. Export Settings Window

Save As. Choose a name for your exported video (default: ScreenFlow.mp4).

Where. Choose a location to export your video.

Preset. ScreenFlow has several export presets for your convenience. This tour focuses 
on the most commonly used presets.

• Web-High. This is the default export option which encodes using the H.264 codec. 
It was chosen as the default codec based on both image quality and file size.

• Web-Low. This is an export option similar to Web-High, but formatted for a low 
bandwidth. It plays more smoothly on slow Internet connections but the image 
quality is not as good as Web-High.

iPad / iPhone / Apple TV / iPod. These export options are formatted based on the 
recommended video specifications for these devices. They cannot be altered.
ScreenFlow User Guide
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Dimensions

These options are used to set the dimensions of your video export. You should not set a 
size larger that your canvas size. This does not improve image quality.

Scale by. Use this option to scale your screencast by a percentage value. This is an easy 
way to shrink your screencast while maintaining the aspect ratio.

Scale to custom size. Use this option to set the exact width and height of your 
exported video. Click the Letterbox Content box to add letterboxing to your export.

Publishing
In addition to encoding a video file, ScreenFlow can also publish screencasts directly to 
Vimeo, YouTube, Google Drive, Facebook, and Wistia. These options are accessible from 
the File menu. For more information, see Publishing Your ScreenFlow Project.
ScreenFlow User Guide
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